
Produktbeschreibung 

Mentype® Chimera® PCR Amplification Kit ist eine Multiplex-Anwendung für 
besondere Fragestellungen im humanmedizinischen Bereich. Das Kit wurde speziell 
entwickelt um das Anwachsen von Spenderzellen nach Knochenmarktransplantation zu 
kontrollieren, was durch Chimärismusanalysen bei über 200 HLA-abgestimmten 
Spender- und Empfängerpaaren validiert wurde.  
 
Mit dem Mentype® Chimera® PCR Amplification Kit werden die zwölf hoch-
polymorphen autosomalen Loci D2S1360, D3S1744, D4S2366, D5S2500, D6S474, 
D7S1517, D8S1132, D10S2325, D12S391, D18S51, D21S2055, SE33 (ACTBP2) 
und der geschlechtsspezifische Amelogenin-Locus simultan in einem PCR-Ansatz 
amplifiziert. Die Primer sind mit den Fluoreszenzfarbstoffen 6-FAM, BTG oder BTY 
markiert.  
 
Die Nachweisgrenze für das Mentype® Chimera® PCR Amplification Kit liegt bei 
200 pg genomischer DNA. Der optimale Bereich ist unter Standardbedingungen 0.2-
1.0 ng DNA. Interne Validierungen haben gezeigt, dass interpretierbare Ergebnisse 
auch mit <0.1 ng DNA erzielt werden. 
 
Die Validierung und Evaluierung des Testkits wurden am GeneAmp® 9700 
Thermocycler, Eppendorf Mastercycler ep-S, Biometra, ABI PRISM® 310 
Genetic Analyzer und ABI PRISM® 3130 Genetic Analyzer durchgeführt.  
Die Entwicklung, die Herstellung und der Vertrieb der Biotype® Produkte ist zertifiziert 
nach DIN EN ISO 9001:2008. 
 
 

Mentype® Chimera® PCR Amplification Kit 
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1. Beschreibung des Mentype® Chimera® 

Tabelle 1. Locus-spezifische Informationen für Mentype® Chimera® 
Locus GenBank® 

Accession 
Repeatmotiv 
des Referenz Alleles 

Referenz 
Allel 

Allel- 
Bereich 

Amelogenin X M55418    
Amelogenin Y M55419    
D2S1360 G08130 [TATC]9 [TGTC]9 [TATC]5 23 19-32 
D3S1744 G08246 [TCTA]2 TA[TCTA]12 TCA [TCTA]2 16 13-22 
D4S2366 G08339 [ATAG]9 ATTG [ATAG]2 12 9-15 
D5S2500 G08468 [ATAG]12 12 9-18 
D6S474 G08540 [TAGA]5 TGA [TAGA]12 17 11-20 
D7S1517 G18365 [GAAA]11 CAAA [GAAA]2 CAAA [GAAA]2 17 14-31 
D8S1132 G08685 [TCTA]9 TCA [TCTA]9 TCTGTCTA 20 12.1-27 
D10S2325 G08790 [TCTTA]12 12 6-23 
D12S391 G08921 [AGAT]5 GAT [AGAT]7 [AGAC]6 AGAT 19.3 13-28 
D18S51 L18333 [AGAA]13 13 5.3-42 
D21S2055 G27274 [CTAT]2 CTAA [CTAT]9 CTA [CTAT]3 TAT 

[CTAT]3 TAT [CTAT]4 CAT[CTAT]2 
24 16.1-39 

SE33 (ACTBP2) NG000840 [AAAG]9 AA [AAAG]16 25.2 3-50 
 
Tabelle 1 zeigt die STR Loci mit ihren Repeatmotiven und Allelen. Die Nomenklatur 
entspricht den Leitlinien der International Society for Forensic Genetics (ISFG), Bär et 
al. (1997). Für die STR Loci D8S1132 und D12S391gilt die Nomenklatur nach S 
Hering und E Müller (2001), für die Loci D4S2366 und D6S474 die nach Becker et al. 
(2007), für den Locus D10S2325 die nach Wiegand et al. (1999) und für den Locus 
D7S1517 gilt die Nomenklatur nach P Wiegand und M Klintschar (2002). Der 
angegebene Allelbereich berücksichtigt die bekannten Allele des National Institute of 
Standards and Technology (NIST, Stand 12/2008) sowie die aktuelle Literatur. 
 
 
Tabelle 2. Chromosomale Kartierung für Mentype® Chimera® 
Locus Chromosomale Kartierung   
Amelogenin X Xp22.1-22.3   
Amelogenin Y Yp11.2   
D2S1360 2p24-p22   
D3S1744 3p24   
D4S2366 4p16-15.2   
D5S2500 5q11.2   
D6S474 6q21-22   
D7S1517 7q31.33   
D8S1132 8q23.1   
D10S2325 10p12   
D12S391 12p13.2   
D18S51 18q21.3   
D21S2055 21q22   
SE33 6q14.2   
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Inhalt 

Mentype® Chimera® PCR Amplification Kit (100 Reaktionen) 
Nuklease-freies Wasser / Nuclease-free water 3.0 mL 
Reaktionsgemisch A / Reaction mix A 500 μL 
Primergemisch / Primer mix 250 μL 
DNA Polymerase / DNA polymerase 40 μL 
Kontroll-DNA XY5 / Control DNA XY5 (2 ng/μL) 10 μL 
DNA Längenstandard 550 (BTO) / DNA Size Standard 550 (BTO) 50 μL 
Allelleiter / Allelic ladder 25 μL 
 
 
Bestellinformation 
Mentype® Chimera® 25 Reaktionen Artikelnummer 45-13210-0025 
Mentype® Chimera® 100 Reaktionen Artikelnummer 45-13210-0100 
Mentype® Chimera® 400 Reaktionen Artikelnummer 45-13210-0400 
Mentype® Chimera® 1000 Reaktionen Artikelnummer 45-13210-1000 

 
 
Lagerung 

Die Lagerung über einen längeren Zeitraum empfehlen wir bei –20°C. Wiederholtes 
Auftauen und Einfrieren sollte vermieden werden. Das Primergemisch und die 
Allelleiter sollten lichtgeschützt aufbewahrt werden. Die DNA-Proben und post-PCR 
Reagenzien (Allelleiter und DNA-Längenstandard) sollten getrennt von den PCR 
Reagenzien gelagert werden. Die Haltbarkeit des Testkits ist auf dem 
Verpackungsetikett angegeben.  
 
 
Zusätzliche Reagenzien 

Für die Amplifikation und Probenvorbereitung benötigen Sie neben den im Biotype® 
Testkit enthaltenen Bestandteilen folgende Reagenzien: 
Reagenz Lieferant Bestellnummer 
Hi-Di™ Formamide, 25 mL Applied Biosystems 4311320 
Matrix Standards BT5 
single-capillary instruments (5x25 μL) 

Biotype Diagnostic GmbH 00-10411-0025 

Matrix Standards BT5 
multi-capillary instruments (25 μL) Biotype Diagnostic GmbH 00-10421-0025 

Matrix Standards BT5 
multi-capillary instruments (50 μL) Biotype Diagnostic GmbH 00-10421-0050 
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Warnungen und Sicherheitshinweise 
Folgende potenziell gefährliche Substanz ist in diesem Testkit enthalten: 
Kitbestandteil Chemikalie Gefahr 
Reaktionsgemisch und Allelleiter Natriumazid NaN3 giftig beim Verschlucken, entwickelt bei 

Berührung mit Säure giftige Gase 

Bitte beachten Sie das Sicherheitsdatenblatt. 
Für Biotype® Kitkomponenten sind die Sicherheitsdatenblätter bei uns erhältlich. Für 
Sicherheitsdatenblätter von Reagenzien, die nicht im Testkit enthalten sind, 
kontaktieren Sie bitte den jeweiligen Hersteller. 
 
 
Qualitätssicherung 

Der gesamte Inhalt des Testkits wird einer intensiven Qualitätssicherung durch die 
Biotype Diagnostic GmbH unterzogen. Die Qualität der Testkits wird kontinuierlich 
überprüft, um die uneingeschränkte Verwendbarkeit zu belegen. Bitte kontaktieren Sie 
uns in allen Fragen zur Qualitätssicherung. 
 
 

Warenzeichen und Patente 
Mentype®, Chimera® sind eingetragene Warenzeichen der Biotype Diagnostic GmbH. 
GenoProof® ist ein eingetragenes Warenzeichen der Qualitype AG. 
ABI PRISM®, GeneScan®, Genotyper® GeneMapper™ und Applied Biosystems sind 
eingetragene Warenzeichen der Applied Biosystems Inc. 
6-FAM, POP-4 und Hi-Di sind Warenzeichen der Applied Biosystems Inc.  
GeneAmp® ist ein eingetragenes Warenzeichen von Roche Molecular Systems.  
Die PCR ist patentrechtlich geschützt. Patentinhaber sind die Firmen Roche Molecular 
Systems und F. Hoffmann-La Roche (Roche). 
GenBank® ist ein eingetragenes Warenzeichen vom National Institute of Health. 
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2. PCR Amplifikation 

2.1 Ansatz des Master Mixes 

Die folgende Tabelle zeigt die Volumina der eingesetzten Kitbestandteile bei 1.0 μL 
Probenvolumen (Template-DNA) in einem Reaktionsvolumen von 25 μL. 
Berücksichtigen Sie bei der Anzahl der PCR-Reaktionen die Positiv- und 
Negativkontrolle. Fügen Sie zu dieser Zahl ein oder zwei Reaktionen hinzu, um 
Pipettierfehler zu kompensieren.  
 
Komponente Volumen 
Nuklease-freies Wasser 16.1 μL 
Reaktionsgemisch A* 5.0 μL 
Primergemisch 2.5 μL 
Multi Taq2 DNA Polymerase (hot start, 2.5 U/μL) 0.4 μL 
Volumen des Master Mixes 24.0 μL 

* enthält Mg2+, dNTPs, BSA 

 
Alle Reagenzien sollten vor dem Ansetzen des Master Mixes gemischt (Vortex) und kurz 
zentrifugiert werden (ca. 10 s).  
Die Menge der einzusetzenden DNA richtet sich nach ihrer Konzentration. Für 
Vergleichsproben ist meist 1 μL ausreichend. Für kritische Patientenproben kann die 
Templatemenge entsprechend erhöht werden. Die Menge an Nuklease-freiem Wasser 
ist entsprechend zu korrigieren, sodass das Gesamtvolumen des PCR-Ansatzes immer 
25 μL beträgt. 
 
Lagern Sie Ihre DNA-Proben in Nuklease-freiem Wasser oder in verdünntem TE Puffer 
(10 mM Tris HCl, pH 8.0 und 1 mM EDTA), z.B. 0.1x TE Puffer. 
 

Die Primergemische sind so eingestellt, dass bei 30 PCR-Zyklen mit 0.5 ng 
Kontroll-DNA XY5 in einem Reaktionsvolumen von 25 μL ausgewogene Peakhöhen 
erreicht werden. Wird mehr Template-DNA eingesetzt, so sind bei kleinen PCR-
Fragmenten sehr hohe Peaks und bei größeren PCR-Fragmenten verhältnismäßig 
niedrige Peaks zu erwarten. Reduzieren Sie die DNA-Menge, um diese 
Unausgewogenheit zu korrigieren. 
 

Positivkontrolle 
Für die Positivkontrolle verdünnen Sie die Kontroll-DNA XY5 auf 0.5 ng in dem 
entsprechenden Volumen. Pipettieren Sie die verdünnte Kontroll-DNA anstelle der 
Template-DNA in die Reaktionsgefäße mit dem vorgelegten PCR Master Mix. 
 

Negativkontrolle 

Als Negativkontrolle pipettieren Sie Nuklease-freies Wasser an Stelle der Template-
DNA in die Reaktionsgefäße mit dem vorgelegten PCR Master Mix. 
 

Template DNA 

In Abhängigkeit von der angewandten Quantifizierungsmethode kann der Messwert der 
DNA-Konzentration variieren, so dass die optimale DNA-Menge ggf. anzugleichen ist. 

Protokolle für die Amplifikation, Elektrophorese und Auswertung
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2.2 PCR Amplifikationsparameter 

Um die Multi Taq2 DNA Polymerase zu aktivieren und die Bildung von unspezifischen 
Amplifikationsprodukten zu unterdrücken, sollte unbedingt ein „hot start“ durchgeführt 
werden.  
 
Die Zyklenzahl ist abhängig von der DNA-Menge. Für alle Proben werden 30 PCR-
Zyklen empfohlen. Für kritisches Material (< 100 pg DNA) werden optional 32 Zyklen 
empfohlen, um optimale Signalintensitäten zu erreichen. 
 

Standard Methode 

Empfohlen für alle DNA-Proben 
Temperatur Zeit 
94°C 4 min (hot start für Aktivierung der Multi Taq2 DNA Polymerase) 
94°C 30 s 
60°C 120 s 
72°C 75 s 

30 Zyklen 

68°C 60 min  
10°C ∞ bis zum Ende 
 
 

Optional 

Empfohlen für geringe DNA-Mengen 
Temperatur Zeit 
94°C 4 min (hot start für Aktivierung der Multi Taq2 DNA Polymerase) 
94°C 30 s 
60°C 120 s 
72°C 75 s 

32 Zyklen 

68°C 60 min  
10°C ∞ bis zum Ende 

 
Anmerkung: Für eine optimale Kitbalance empfehlen wir bei PCR-Geräten mit 
schnellen Heiz- und Kühlraten (> 2°C/s) das Ramping auf maximal 2°C/s einzustellen.  
 
Aufgrund zu geringer DNA-Mengen kann es zu statistischen Ausfällen (Allelic Dropouts) 
und unausgewogenen Peakhöhen kommen. Außerdem steigt die Wahrscheinlichkeit 
von unspezifischen Amplifikationsprodukten. Mit zunehmender Zyklenzahl können 
zudem Kreuzkontaminationen durch minimale Mengen an Fremd-DNA auftreten. 
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3. Elektrophorese am ABI PRISM® 310 Genetic Analyzer  

Allgemeine Anweisungen zum Analysegerät, der Matrixerstellung und der Anwendung 
der GeneScan® bzw. GeneMapper™ ID Software können der entsprechenden 
Anleitung ABI PRISM ® 310 Genetic Analyzer User’s Manual entnommen werden. Im 
Folgenden wird die Elektrophorese mit der GeneScan® Software beschrieben. 
 
Für den kombinierten Einsatz der fünf Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, BTR 
und BT0 (der Matrix Standard wird im Folgenden als BT5 bezeichnet) ist die Nutzung 
des virtuellen Filter Sets G5 vorgesehen.  
 
Material  
Kapillare 47 cm / 50 μm (grün) 
Polymer POP-4 for 310 Genetic Analyzer 
Puffer 10x Genetic Analyzer Buffer with EDTA 
 

3.1 Matrixerstellung 

Vor der Durchführung der Fragmentlängenanalyse mit dem Filter Set G5 muss 
zunächst eine Matrix mit PCR-Fragmenten der entsprechenden fünf 
Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, BTR und BTO für das jeweilige Analysegerät 
erstellt werden.  
 
Farbe Matrix Standard  
Blau (B) 6-FAM  
Grün (G) BTG  
Gelb (Y) BTY  
Rot (R) BTR  
Orange (O) BTO  
 

Zur Erstellung von geeigneten Matrix Files werden fünf Elektrophoresen unter den 
gleichen Bedingungen ausgeführt wie sie auch für Proben und Allelleitern des Biotype® 
Testkits gelten. Für die fünf verschiedenen Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, 
BTR und BTO muss jeweils ein eigener Elektrophoreselauf durchgeführt werden. 
 
Matrix Probe Komponente Volumen 

Hi-Di™ Formamide 12.0 μL 
Matrix Probe 1 

Matrix Standard 6-FAM 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix Probe 2 

Matrix Standard BTG 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix Probe 3 

Matrix Standard BTY 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix Probe 4 

Matrix Standard BTR 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix Probe 5 

Matrix Standard BTO 1.0 μL 
- 3 min denaturieren bei 95°C 
- abkühlen auf 4°C 
- gesamten Probenansatz zur Analyse auf Tray laden 
 

- Probenliste Sample Sheet erstellen, 5 Dyes auswählen und Proben bezeichnen
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Injektionsliste für die Matrixerstellung 
Parameter Einstellung 
Module File GS STR POP-4 (1 mL) G5 
Matrix File NONE 
Size Standard* NONE 
Injection [s] 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min] 24 

* Matrix Standards sind immer ohne DNA Längenstandard (BTO) vorzubereiten  
 

Analyse der Matrix Proben 

- Starten der GeneScan® Software 
- File → New → Project (Ordner des entsprechenden Laufs öffnen) 
   → Add Sample Files 
- Markieren der Matrix Probe in der Spalte Sample File  
- Sample → Raw Data 
- Bewerten, ob eine stabile Basislinie vorhanden ist. Wie in der Abbildung gezeigt 

sollten mindestens fünf Peaks mit Peakhöhen von 1000-4000 (Y-Achse) in jeder 
Matrix Probe erkennbar sein (optimaler Bereich: 2000-4000) 

 

 
Abb. 1 Elektropherogramm der Rohdaten des Matrix Standards 6-FAM 
 
- Auswahl des Analysebereichs mit stabiler, ebener Basislinie 
- Falls notwendig, injizieren Sie die Matrix Probe noch einmal 
- Notieren von Anfangs- und Endpunkten (Data Points) des Auswahlbereiches, z.B.  
   Anfangswert 3200, Endwert 5500 
- Differenzwert berechnen, z.B. 5500-3200 = 2300 Data Points 

▼ 3200 Data Points (X) 
 

 5500▼ 
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Neue Matrix erstellen 

- File → New → Matrix 

 
Abb. 2 Matrix Proben auswählen 
 
- Matrix Proben für jede Farbe (B, G, Y, R, O) importieren 
- Jeweiligen Anfangspunkt bei Start At eintragen, z.B. 3200 
- Errechneten Differenzwert z.B. 2300 bei Points eintragen 
- Nach der Bestätigung mit OK wird die neue Matrix berechnet 
 

 
Abb. 3 Neue Matrix BT5 
 

- Speichern im Matrix Ordner: File → Save As, z.B. Matrix BT5 
 
Matrix prüfen 

Bitte überprüfen Sie die neue Matrix mit Ihren aktuellen Proben. 
- File → New → Project (Ordner des entsprechenden Laufs öffnen) 
   → Add Sample Files 
- Markieren Sie die aktuelle Probe in der Spalte Sample File  
- Sample → Install New Matrix  
   (Matrix Ordner öffnen und neue Matrix auswählen) 
- Proben neu analysieren 
 
Mit der neuen Matrix sollten keine Überstrahlungen (Pull-up Peaks) zwischen den 
verschiedenen Farbpaneln (B, G, Y, R, O) auftreten. 
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3.2 Probenvorbereitung  
Komponente Volumen 
Hi-Di™ Formamide 12.0 μL 
DNA Längenstandard 550 (BTO) 0.5 μL 
12 μL Gemisch (Formamid+ Längenstandard) für alle Proben vorlegen  
  1 μL PCR-Produkt (ggf. verdünnt) bzw. Allelleiter zugeben 
- 3 min denaturieren bei 95°C 
- abkühlen auf 4°C 
- gesamten Probenansatz zur Analyse auf Tray laden 
 
 
Signalintensitäten 

Möglichkeiten zur Erhöhung der Signalintensitäten: 
- Reduzierung der Anteile am DNA Längenstandard 550 (BTO) auf Peakhöhen von  
  ca. 500 relativen Fluoreszenzeinheiten (RFU) 
- Aufreinigung der PCR-Produkte vor der Analyse 
 
 

3.3 Einstellung der GeneScan® Software 

- Probenliste Sample Sheet erstellen und Proben bezeichnen 
 
Injektionsliste 
Parameter Einstellung 
Module File GS STR POP-4 (1 mL) G5 
Matrix File z.B. Matrix BT5 
Size Standard z.B. SST-BTO_60-500bp 
Injection [s]* 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min]** 28 

* Abweichend von der Standardeinstellung kann die Injektionszeit je nach Probe zwischen 1 und 10 s betragen. 
Handelt es sich um Vergleichsproben mit sehr hohen Peakhöhen, kann zur Vermeidung von Überstrahlungen 
eine kürzere Injektionszeit gewählt werden. Bei geringen DNA Mengen bzw. kritischem Patientenmaterial 
können bis zu 10 s notwendig sein. 
 
** Abhängig von den Analysebedingungen ist die Run Time für Mentype® Chimera® angepasst worden, damit 
Fragmente bis zu einer Länge von 500 bp analysiert werden können. 
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3.4 Analyse Parameter 

Die empfohlenen Analyse Parameter sind: 
 
Analysis Range Start: 2000 

Stop: 10000 
Data Processing Baseline: Checked 

Multicomponent: Checked 
Smooth Options: Light 

Peak Detection Peak Amplitude Thresholds 
B:*    Y:* 
G:*    R:* 
O:* 
Min. Peak Half Width: 2 pts 
Polynominal Degree: 3 
Peak Window Size: 11 pts** 

Size Call Range Min: 60 
Max: 550 

Size Calling Method Local Southern Method 
Split Peak Correction None 

* Der Grenzwert der Peakamplituden (threshold) ist die minimale Peakhöhe, welche die GeneScan® bzw. 
GeneMapper™ ID Software als einen Peak erkennt. Übliche Werte sind 50-200 RFU und sollten individuell vom 
Analyselabor festgelegt werden. Empfehlung: Die minimale Peakhöhe sollte mindestens 3x so hoch sein wie das 
Grundrauschen der Basislinie. 
 
** Gelegentlich können Punktallele, d.h. Allele mit einem Abstand von mindestens 1 bp zum nächsten 
ganzzahligen Allel, nicht unterschieden werden. Falls notwendig kann die Peak Window Size noch weiter 
verringert werden. 



 

Mentype® Chimera® September 2010 

13 

4. Elektrophorese am ABI PRISM® 3100-Avant/3100 Genetic Analyzer 

Allgemeine Anweisungen zum Analysegerät, zur Spektralkalibrierung und der 
Anwendung der ABI PRISM® 3100 Data Collection Software Version 1.01 oder 1.1 
sowie der GeneScan® Software können dem entsprechenden ABI PRISM ® 3100-
Avant/3100 Genetic Analyzer User’s Manual entnommen werden.  
 
Das 4-Kapillarsystem trägt die Bezeichnung ABI 3100-Avant, das 16-Kapillarsystem 
heißt ABI 3100. 
 
Für den kombinierten Einsatz der fünf Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, BTR 
und BT0 (der Matrix Standard wird im Folgenden als BT5 bezeichnet) ist die Nutzung 
des virtuellen Filter Sets G5 vorgesehen. 
 
Material  
Kapillare 36 cm Capillary Array for 3100-Avant/3100 
Polymer POP-4 Polymer for 3100 
Puffer 10x Genetic Analyzer Buffer with EDTA 
 
 
4.1 Spektralkalibrierung / Matrixerstellung 
Vor der Durchführung der Fragmentlängenanalyse muss zunächst eine Spektral-
kalibrierung am ABI PRISM® 3100-Avant/3100 Genetic Analyzer durchgeführt werden. 
Auf diese Weise wird eine Matrix erstellt, die das Überlappen der farbspezifischen 
Fluoreszenzemissionsspektren korrigiert.  
 
Die Spektralkalibrierung gliedert sich in die folgenden Abschnitte: 
- Vorbereitung der Matrix Standards zur Spektralkalibrierung 
- Laden der Standards in die 96-Lochplatte (je Kapillare eine Probe) 
- Plattenzusammensetzung eingeben 
- Durchführung des Laufs zur Spektralkalibrierung und prüfen der Matrix 
 
Vorbereitung der Matrix Standards zur Spektralkalibrierung 

Beispiel für 4 Kapillaren/ABI 3100-Avant 
Komponente Volumen 
Hi-Di™ Formamide 60.0 μL 
Matrix Standard BT5 5.0 μL 
- 12 μL des Gemisches in 96-Lochplatte laden, z.B. Position A1-D1 
- 3 min denaturieren bei 95°C  
- abkühlen auf 4°C 
 
Beispiel für 16 Kapillaren/ ABI 3100 
Komponente Volumen 
Hi-Di™ Formamide 204.0 μL 
Matrix Standard BT5 17.0 μL 
- 12 μL des Gemisches in 96-Lochplatte laden, z.B. Position A1-H1 und A2-H2 
- 3 min denaturieren bei 95°C 
- abkühlen auf 4°C 
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Durchführung der Spektralkalibrierung 

Um eine erfolgreiche Kalibrierung mit der Data Collection Software Version 1.0.1 oder 
1.1 durchzuführen, muss zunächst einmalig die Parameter Datei für DyeSetG5 
verändert werden.  
 

Spectral Parameter 

- Änderung der Parametereinstellungen unter dem Pfad:  
D:\AppliedBio\Support Files\Data Collection Support Files\ CalibrationData\Spectral 
Calibration\ ParamFiles 

- MtxStd{Genescan_SetG5} auswählen, um die PAR-Datei zu öffnen 
- Änderung des Condition bounds range auf [1.0;20.0]. Falls eine Kalibrierung nicht 

möglich ist, können im zweiten Schritt zusätzlich die Parameter Sensitivity auf 0.1 
und Quality auf 0.8 geändert werden 

- File Save As auswählen, um die Parameter Datei unter einem neuen Namen zu 
speichern, z.B. MtxStd{Genescan_SetG5_BT5}.par 

 
Verwenden Sie für die Spektralkalibrierung mit Biotype® Matrix Standards BT5 immer 
die soeben erstellte Parameter Datei. 
 
Platteneditor zur Spektralkalibrierung (I) 
- Die vorbereitete 96-Lochplatte in den Autosampler setzen  
- Öffnen der ABI PRISM® 3100 Data Collection Software 
- Im Plate View der 3100 Data Collection Software auf New klicken, um den Plate 

Editor Dialog zu öffnen 
- Name der Platte eingeben 
- Spectral Calibration auswählen 
- 96-Well als Plattentyp auswählen und Finish wählen 
 
Platteneditor zur Spektralkalibrierung (II) 
Parameter Einstellung 
Sample Name Benennung der Matrixproben 
Dye Set  G5 
Spectral Run Module Default (z.B. Spect36_POP4) 
Spectral Parameters MtxStd{GeneScan_SetG5_BT5}.par (Parameter zuvor erstellt) 
 
- In die oberste Zelle der Tabelle klicken, um die gesamte Spalte auszuwählen, über  

Edit → Fill Down die Informationen den ausgewählten Matrixproben zufügen und 
mit OK bestätigen 

- Verknüpfen der 96-Lochplatte auf dem Autosampler mit der soeben erstellten 
Plattenbezeichnung und den Lauf starten 

- Nach dem Lauf unter Spectral Calibration Result prüfen, ob alle Kapillaren 
erfolgreich kalibriert wurden (Kennzeichnung A). Bei Kennzeichnung X sind die 
Anweisungen im ABI PRISM ® Genetic Analyzer User’s Manual zu beachten 

- Auf OK klicken, um den Lauf zu bestätigen  
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Matrix prüfen 

- Wähle Tools → Display Spectral Calibration → Dye Set → G5, um die 
Spektralkalibrierung jeder Kapillare zu kontrollieren  

- Jede Kapillare sollte einen Qualitätswert (Q Value) von mindestens 0.95 sowie eine 
Konditionszahl (C Value) zwischen 1 und 20 haben, beide Werte müssen im zuvor 
festgelegten Bereich liegen 

- Bewerten, ob eine stabile Basislinie vorhanden ist. Es müssen fünf Peaks mit 
Peakhöhen von 1000-5000 (Y-Achse) in jeder Kapillare erkennbar sein (optimaler 
Bereich: 2000-4000) 

- Bitte überprüfen Sie die neue Matrix mit Ihren aktuellen Proben. Mit der neuen Matrix 
sollten keine Überstrahlungen (Pull-up Peaks) zwischen den verschiedenen 
Farbpanels (B, G, Y, R, O) auftreten 

- War die Kalibrierung nicht erfolgreich, ändern Sie bitte die Werte für Sensitivity und 
Quality wie zuvor in der Parameter Datei beschrieben 

- Haben alle Kapillaren die Kalibrierung erfolgreich durchlaufen, muss die aktuelle 
Kalibrierungsdatei für das Dye Set G5 unter Tools → Set Active Spectral 
Calibration manuell aktiv gesetzt werden. Eine Umbenennung ist über Set Matrix 
Name möglich (z.B. BT5_Datum der Kalibrierung) 

 

4.2 Probenvorbereitung 
Komponente Volumen 
Hi-Di™ Formamide 12.0 μL 
DNA Längenstandard 550 (BTO) 0.5 μL 
12 μL Gemisch (Formamid+ Längenstandard) für alle Proben vorlegen 
  1 μL PCR-Produkt (ggf. verdünnt) oder Allelleiter zugeben 
- 3 min denaturieren bei 95°C  
- abkühlen auf 4°C  
- gesamten Probenansatz zur Analyse auf Tray laden  
 
Da die Injektion gleichzeitig an allen Kapillaren stattfindet, müssen am 
Mehrkapillargerät immer 4 oder 16 Proben auf der Platte pipettiert werden. Falls 
weniger Proben zu messen sind, müssen die entsprechenden Positionen mit 12 μL   
Hi-Di™ Formamide aufgefüllt werden. 
 

Um eine sichere Allelzuordnung am Mehrkapillargerät zu gewährleisten, sollten 
unabhängig von der Probenanzahl mehrere Allelleitern mitlaufen. 
 

Die Raumtemperatur kann das Laufverhalten der PCR-Produkte an Mehrkapillargeräten 
stark beeinflussen und bei zu geringer Temperatur zum Auftreten von Doppelpeaks 
(Split Peaks) führen. Unter Umständen nimmt die Temperatur auch Einfluss auf die 
Laufgeschwindigkeit der Fragmente. Bitte achten Sie darauf, dass die vom 
Gerätehersteller empfohlene Arbeitstemperatur eingehalten wird. 
 
Signalintensitäten 

Möglichkeiten zur Erhöhung der Signalintensitäten: 
- Reduzierung des Anteiles am DNA Längenstandard 550 (BTO) auf Peakhöhen von  
  ca. 500 relativen Fluoreszenzeinheiten (RFU) 
- Aufreinigung der PCR Produkte vor der Analyse 
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4.3 Einstellung der GeneScan® Software 

Vor dem ersten Lauf muss das voreingestellte Run Modul im Dye Set G5 einmalig editiert 
werden: 
- Zum Öffnen der Dialog Box auf Module Editor klicken 
- Aus der Tabelle GeneScan das entsprechenden Run Module als Vorlage auswählen 
- Ändern Sie die Spannung (Injection Voltage) auf 3 kV und die Injektionszeit 

(Injection Time) auf 10 s 
 

Run Modul 3kV_10s_500bp 
Parameter Einstellung 
Run Temperature [°C] Default 
Cap Fill Volume Default 
Maximum Current [A] Default 
Current Tolerance [A] Default 
Run Current [A] Default 
Voltage Tolerance [kV] Default 
Pre Run Voltage [kV] Default 
Pre Run Time [s] Default 
Injection Voltage [kV] 3.0 
Injection Time [s]* 10 
Run Voltage [kV] Default 
Number of Steps Default 
Voltage Step Interval Default 
Data Delay Time [s] Default 
Run Time [min]** 26 

* Abweichend von der Standardeinstellung kann die Injektionszeit je nach Probe zwischen 1 und 20 s betragen. 
Handelt es sich um Vergleichsproben mit sehr hohen Peakhöhen, kann zur Vermeidung von Überstrahlungen 
eine kürzere Injektionszeit gewählt werden. Bei geringen DNA Mengen bzw. kritischem Patientenmaterial 
können bis zu 20 s notwendig sein. 
 

** Abhängig von den Analysebedingungen ist die Run Time für Mentype® Chimera® angepasst worden, damit 
Fragmente bis zu einer Länge von 500 bp analysiert werden können. 
 

- Auf Save As klicken, den Namen des neuen Moduls eingeben (z.B. 
3kV_10s_500bp) und mit OK bestätigen  

- Zum Verlassen des Run Module Editors auf Close klicken 
 
 
Run starten 

- Die vorbereitete 96-Lochplatte in den Autosampler setzen 
- Öffnen der ABI PRISM® 3100 Data Collection Software 
- Im Plate View der 3100 Data Collection Software auf New klicken, um den Plate 

Editor Dialog zu öffnen 
- GeneScan auswählen 
- 96-Well als Plattentyp auswählen und Finish anklicken 
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Platteneditor 
Parameter Einstellung 
Sample Name Benennung der Proben 
Dyes  O 
Colour Info Ladder or Sample 
Project Name z.B. 3100_Project1 
Dye Set  G5 
Run Module* 3kV_10s_500bp 
Analysis Module 1 DefaultAnalysis.gsp 

* Parameter siehe oben 
 
- Vervollständigen der Tabelle im Plate Editor und OK wählen 
- In die oberste Zelle der Tabelle klicken, um die gesamte Spalte auszuwählen und 

Edit → Fill Down wählen, um die Informationen der ausgewählten Probe zu-
zuordnen 

- Verknüpfen der 96-Lochplatte auf dem Autosampler mit der soeben erstellten 
Plattenbezeichnung und den Lauf starten 

- Nach dem Lauf sind die Daten als Color Data in Array View der 3100 Data 
Collection Software oder als Analyzed Sample Files unter dem Pfad 
D:/AppliedBio/3100/DataExtractor/ExtractRuns vorzufinden 

 
 

4.4 Analyse Parameter 

Die empfohlenen Analyse Parameter sind: 
 
Analysis Range Start: 2000 

Stop: 10000 
Data Processing Baseline: Checked 

Multicomponent: Checked 
Smooth Options: Light 

Peak Detection Peak Amplitude Thresholds 
B:*    Y:* 
G:*    R:* 
O:* 
Min. Peak Half Width: 2 pts 
Polynominal Degree: 3 
Peak Window Size: 11 pts** 

Size Call Range Min: 60 
Max: 550 

Size Calling Method Local Southern Method 
Split Peak Correction None 
 

* Der Grenzwert der Peakamplituden (threshold) ist die minimale Peakhöhe, welche die GeneScan® bzw. 
GeneMapper™ ID Software als einen Peak erkennt. Übliche Werte sind 50-200 RFU und sollten individuell vom 
Analyselabor festgelegt werden. Empfehlung: Die minimale Peakhöhe sollte mindestens 3x so hoch sein wie das 
umgebende Grundrauschen der Basislinie. 
 
** Gelegentlich können Punktallele, d.h. Allele mit einem Abstand von mindestens 1 bp zum nächsten 
ganzzahligen Allel, nicht unterschieden werden. Falls notwendig kann die Peak Window Size noch weiter 
verringert werden. 
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5. Elektrophorese am ABI PRISM® 3130/3130xl Genetic Analyzer 

Allgemeine Anweisungen zum Analysegerät, zur Spektralkalibrierung und der 
Anwendung der ABI PRISM® Data Collection Software Version 3.0 und der 
GeneMapper™ ID Software können der entsprechenden Anleitung ABI PRISM ® 
3130/3130xl Genetic Analyzers Getting Started Guide entnommen werden. 
 
Das 4-Kapillarsystem trägt die Bezeichnung ABI 3130, das 16-Kapillarsystem heißt 
ABI 3130xl. 
 
Für den kombinierten Einsatz der fünf Fluoreszenzfarbstoffe 6-FAM, BTG, BTY, BTR 
und BT0 (der Matrix Standard wird im Folgenden als BT5 bezeichnet) ist die Nutzung 
des virtuellen Filter Sets Any5Dye vorgesehen.  
 
Material  
Kapillare 36 cm Capillary Array for 3130/3130xl 
Polymer POP-4 Polymer for 3130 
Puffer 10x Genetic Analyzer Buffer with EDTA 
 
 

5.1 Spektralkalibrierung / Matrixerstellung 

Vor der Durchführung der Fragmentlängenanalyse muss zunächst eine Spektral-
kalibrierung mit PCR-Fragmenten der entsprechenden fünf Fluoreszenzfarbstoffe  
6-FAM, BTG, BTY, BTR und BTO für das jeweilige Analysegerät durchgeführt werden. 
Auf diese Weise wird eine Matrix erstellt, die das Überlappen der farbspezifischen 
Fluoreszenzemissionsspektren korrigiert.  
 
Die Spektralkalibrierung gliedert sich in die folgenden Abschnitte: 
- Vorbereitung der Matrix Standards zur Spektralkalibrierung 
- Laden der Standards in die 96-Lochplatte (je Kapillare eine Probe) 
- Erstellung des Instrument Protocol zur Spektralkalibrierung (Protocol Manager) 
- Plattenzusammensetzung im Platteneditor festlegen (Plate Manager) 
- Durchführung des Laufs zur Spektralkalibrierung und prüfen der Matrix 
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Vorbereitung der Matrix Standards zur Spektralkalibrierung 

Beispiel für 4 Kapillaren/ABI 3130 
Komponente Volumen 
Hi-Di™ Formamide 60.0 μL 
Matrix Standard BT5 5.0 μL 
- 12 μL des Gemisches in 96-Lochplatte laden, z.B. Position A1-D1  
- 3 min denaturieren bei 95°C 
- abkühlen auf 4°C 
 
 
Beispiel für 16 Kapillaren/ABI 3130xl 
Komponente Volumen 
Hi-Di™ Formamide 204.0 μL 
Matrix Standard BT5 17.0 μL 
- 12 μL des Gemisches in 96-Lochplatte laden, z.B. Position A1-H1 und A2-H2 
- 3 min denaturieren bei 95°C  
- abkühlen auf 4°C 
 
 
Durchführung der Spektralkalibrierung 
- Die vorbereitete 96-Lochplatte in den Autosampler setzen 
- Im Protocol Manager der Data Collection Software im Fenster Instrument 

Protocol auf New klicken, um den Protocol Editor zu öffnen 
 
 
Instrument Protocol zur Spektralkalibrierung 
Protocol Editor Einstellung 
Name User (z.B. Spectral36_POP4_BT5) 
Type SPECTRAL 
Dye Set Any5Dye 
Polymer* User (z.B. POP4) 
Array Length* User (z.B. 36cm) 
Chemistry Matrix Standard 
Run Module* Default (z.B. Spect36_POP4_1) 

* Richtet sich nach dem verwendeten Polymertyp und der Kapillarlänge 
 
- OK wählen, um den Protocol Editor zu verlassen 
- Im Plate Manager der Data Collection Software auf New klicken, um New Plate 

Dialog zu öffnen 
 
Platteneditor zur Spektralkalibrierung (I) 
New Plate Dialog Einstellung 
Name z.B. Spectral_BT5_Datum 
Application Spectral Calibration 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- OK wählen. Auf diese Weise öffnet sich automatisch eine neue Tabelle im 

Platteneditor 
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Platteneditor zur Spektralkalibrierung (II) 
Parameter Einstellung 
Sample Name Benennung der Matrixproben 
Priority  z.B. 100  
Instrument Protocol 1 Spectral36_POP4_BT5 (Einstellung zuvor beschrieben) 
 
- In die oberste Zelle der Tabelle klicken, um die gesamte Spalte auszuwählen, über  

Edit → Fill Down diese Information den ausgewählten Matrixproben zufügen und 
mit OK bestätigen 

- In Run Schedule → Find All anklicken, dann link wählen, um die 96-Lochplatte 
auf dem Autosampler mit der soeben erstellten Plattenbezeichnung zu verknüpfen 
(Position A oder B). Anschließend den Lauf starten 

 

 
Abb. 4 Elektropherogramm der Spektralkalibrierung mit Matrix Standards BT5 am ABI 3130 
 
 
Matrix prüfen 

- Jede Kapillare sollte einen Qualitätswert (Q Value) von mindestens 0.95 sowie eine 
Konditionszahl (Condition number range) zwischen 1 und 20 haben 

- Bewerten, ob eine stabile Basislinie vorhanden ist. Es müssen fünf Peaks mit 
Peakhöhen von 1000-5000 (Y-Achse) in jeder Kapillare erkennbar sein (optimaler 
Bereich: 2000-4000), siehe Abbildung 

- Bitte überprüfen Sie die neue Matrix mit Ihren aktuellen Proben. Mit der neuen Matrix 
sollten keine Überstrahlungen (Pull-up Peaks) zwischen den verschiedenen 
Farbpanels (B, G, Y, R, O) auftreten. 

- War die Kalibrierung nicht erfolgreich, ist eine Wiederholung der Spektral-kalibrierung 
mit optimierten Werten notwendig 

        O,          R,       Y,        G,      B 
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- Haben alle Kapillaren die Kalibrierung erfolgreich durchlaufen, wird die Kalibrierungs-
datei für das Any5Dyes im Spectral Viewer automatisch aktiv gesetzt. Eine 
Umbenennung ist über Rename möglich (z.B. BT5_Datum der Kalibrierung) 

 
 

5.2 Probenvorbereitung 
Komponente Volumen 
Hi-Di™ Formamide 12.0 μL 
DNA Längenstandard 550 (BTO) 0.5 μL 
12 μL Gemisch (Formamid+ Längenstandard) für alle Proben vorlegen 
  1 μL PCR-Produkt (ggf. verdünnt) oder Allelleiter zugeben 
- 3 min denaturieren bei 95°C  
- abkühlen auf 4°C  
- gesamten Probenansatz zur Analyse auf Tray laden  
 
Da die Injektion gleichzeitig an allen Kapillaren stattfindet, müssen am 
Mehrkapillargerät immer 4 oder 16 Proben auf der Platte pipettiert werden. Falls 
weniger Proben zu messen sind, müssen die entsprechenden Positionen mit 12 μL   
Hi-Di™ Formamide aufgefüllt werden. 
 
Um eine sichere Allelzuordnung am Mehrkapillargerät zu gewährleisten, sollten 
unabhängig von der Probenanzahl mehrere Allelleitern mitlaufen. 
 
Die Raumtemperatur kann das Laufverhalten der PCR-Produkte an Mehrkapillargeräten 
stark beeinflussen und bei zu geringer Temperatur zum Auftreten von Doppelpeaks 
(Split Peaks) führen. Unter Umständen nimmt die Temperatur auch Einfluss auf die 
Laufgeschwindigkeit der Fragmente. Bitte achten Sie darauf, dass die vom 
Gerätehersteller empfohlene Arbeitstemperatur eingehalten wird. 
 
 
Signalintensitäten 

Möglichkeiten zur Erhöhung der Signalintensitäten: 
- Reduzierung der Anteile am DNA Längenstandard 550 (BTO) auf Peakhöhen von  
  ca. 500 relativen Fluoreszenzeinheiten (RFU) 
- Aufreinigung der PCR-Produkte vor der Analyse 
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5.3 Einstellung der GeneMapper™ ID Software 

Vor dem ersten Probenlauf muss das Run Modul wie folgt editiert werden: 
- Im Module Manager der Data Collection Software auf New klicken, um den Run 

Module Editor zu öffnen 
 
Run Modul 3kV_10s_500bp 
Parameter Einstellung 
Oven Temperature [°C] Default 
Poly Fill Volume Default 
Current Stability [μA] Default 
PreRun Voltage [kV] Default 
PreRun Time [s] Default 
Injection Voltage [kV] 3.0 
Injection Time [s]* 10 
Voltage Number of Steps Default 
Voltage Step Interval Default 
Data Delay Time [s] Default 
Run Voltage [kV] Default 
Run Time [s]** 1560 
 
* Abweichend von der Standardeinstellung kann die Injektionszeit je nach Probe zwischen 1 und 20 s betragen. 
Handelt es sich um Vergleichsproben mit sehr hohen Peakhöhen, kann zur Vermeidung von Überstrahlungen 
eine kürzere Injektionszeit gewählt werden. Bei geringen DNA Mengen bzw. kritischem Patientenmaterial 
können bis zu 20 s notwendig sein. 
 

** Abhängig von den Analysebedingungen ist die Run Time für Mentype® Chimera® angepasst worden, damit 
Fragmente bis zu einer Länge von 500 bp analysiert werden können. 

 
- Auf Save As klicken, den Namen des neuen Moduls eingeben (z.B. 3kV_10s_500bp) 

und mit OK bestätigen 
- Zum Verlassen des Run Module Editors auf Close klicken 
 
 
Run starten 

- Die vorbereitete 96-Lochplatte in den Autosampler setzen 
- Im Protocol Manager der Data Collection Software im Fenster Instrument 

Protocol auf New klicken, um den Protocol Editor zu öffnen 
 
Instrument Protocol 
Protocol Editor Einstellung 
Name z.B. Run36_POP4_BT5_26min 
Type REGULAR 
Run Module* 3kV_10s_500bp 
Dye Set Any5Dye 

* Parameter siehe oben 
 
- OK wählen, um den Protokolleditor zu verlassen 
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Vor jedem Probenlauf muss die zu messende Platte wie folgt angelegt werden: 
- Im Plate Manager der Data Collection Software auf New klicken, um New Plate 

Dialog zu öffnen 
 
GeneMapper™ Platteneditor (I) 
New Plate Dialog Einstellung 
Name z.B. Plate_BT5_Datum 
Application wählen Sie GeneMapper Application 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- OK wählen. Auf diese Weise öffnet sich automatisch eine neue Tabelle im 

Platteneditor 
 
GeneMapper™ Platteneditor (II) 
Parameter Einstellung 
Sample Name Benennung der Probe 
Priority  z.B. 100 (Voreinstellung) 
Sample Type Probe oder Allelleiter 
Size Standard z.B. SST-BTO_60-500bp 
Panel z.B. Chimera_Panels_v0  
Analysis Method z.B. Analysis_HID_3130 
Snp Set - 
User-defined 1-3 - 
Results Group 1 (Results Group auswählen) 
Instrument Protocol 1 Run36_POP4_BT5_26min (Einstellung zuvor beschreiben) 
 
- In die obersten Zellen der Tabelle klicken, um die gesamte Spalte auszuwählen, über  

Edit → Fill Down diese Informationen den ausgewählten Proben zufügen und mit 
OK bestätigen  

- In Run Schedule → Find All anklicken, dann auf link klicken, um die 96-
Lochplatte auf dem Autosampler mit der soeben erstellten Plattenbezeichnung zu 
verknüpfen (Position A oder B). Anschließend den Lauf starten 

- Die Qualität der Rohdaten kann während des Laufs für jede einzelne Kapillare im 
Capillaries Viewer oder Cap/Array Viewer beobachten werden. Mögliche 
Fehlermeldungen (Error Status) erscheinen in Event Log  

- Die Daten des Probenlaufs werden unter Run History oder Cap/Array Viewer der 
Data Collection Software im Überblick dargestellt. Die Laufdaten der Proben werden 
im Run Folder der zuvor gewählten Results Group abgelegt 
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5.4 Analyse Parameter / Analysis Method 

Die empfohlenen Einstellungen im Tabellenblatt Peak Detector sind: 
 
Peak Detection Algorithm Advanced 
Ranges Analysis: Partial Range 

Start Pt: 2000; Stop Pt: 10000 
Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  
Baseline Window: 51 pts 

Size Calling Method Local Southern Method 
Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 
G:*    R:* 
O:* 
Min. Peak Half Width: 2 pts 
Polynominal Degree: 3 
Peak Window Size: 11 pts** 
Slope Thresholds: 0.0 

 
* Der Grenzwert der Peakamplituden (threshold) ist die minimale Peakhöhe, welche die GeneMapper™ ID 
Software als einen Peak erkennt. Übliche Werte sind 50-200 RFU und sollten individuell vom Analyselabor 
festgelegt werden. Empfehlung: Die minimale Peakhöhe sollte mindestens 3x so hoch sein wie das 
Grundrauschen der Basislinie. 

 
** Gelegentlich können Punktallele, d.h. Allele mit einem Abstand von mindestens 1 bp zum nächsten 
ganzzahligen Allel, nicht unterschieden werden. Falls notwendig kann die Peak Window Size noch weiter 
verringert werden. 
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6. Auswertung 

Allgemeine Anweisungen zur automatischen Auswertung können der entsprechenden 
Anleitung GeneScan ® oder GeneMapper™ ID Software User’s Manual  entnommen 
werden. 
 
Anmerkung: Bei der Auswertung des Mentype® Chimera® sollte der rote Panel 
ausgeblendet werden. 
 
Die Ermittlung der genauen Fragmentlängen der amplifizierten Produkte ist abhängig 
vom Gerätetyp, von den Elektrophoresebedingungen sowie von dem verwendeten DNA 
Längenstandard. Aufgrund der Komplexität einiger STR-Loci sollten möglichst viele, 
gleichmäßig verteilte Referenzpunkte zur Längenbestimmung herangezogen werden. 
Hierzu verwenden Sie den DNA Längenstandard 550 (BTO) mit den Fragmentlängen 
60, 80, 90, 100, 120, 140, 160, 180, 200, 220, 240, 250, 260, 280, 300, 320, 
340, 360, 380, 400, 425, 450, 475, 500, 525 und 550 bp. 
 

 
 

Abb. 5 Elektropherogramm des DNA Längenstandard 550 (BTO), Fragmentlängen in bp 
 
 
Anmerkung: Für die Auswertung und Analyse des Mentype® Chimera® mit der 
GeneMapper™ ID Software kann die bereitgestellte Auswertevorlage des DNA-
Längenstandards SST-BTO_60-500bp verwendet werden.  
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6.1 Biotype® Auswertevorlagen 

Die Allelzuordnungen der aufgetrennten PCR-Produkte (Genotyping) kann mit Hilfe 
geeigneter Auswertungssoftware erfolgen, z.B. mit GeneMapper™ ID oder Genotyper® 

Software in Kombination mit Mentype® Chimera® Auswertevorlagen der Biotype. 
Biotype® Auswertevorlagen (Template Files) finden Sie auf unserer Homepage 
(www.biotype.de) zum Download. Auf Anfrage senden wir Ihnen gerne eine CD-ROM 
zu. 
 
Die empfohlenen Biotype® Vorlagen für die GeneMapper™ ID/ID-X Software sind: 
Panels Chimera_Panels_v0/v0X oder höhere Version 
BinSets Chimera_Bins_v0/v0X oder höhere Version 
Size Standard SST-BTO_60-500bp   
Analysis Method Analysis_HID_310  
 Analysis_HID_3130  
 Analysis_HID_310_50rfu  
 Analysis_HID_3130_50rfu  
Plot Settings PlotsBT5_4dyes  
Table Settings Table for 2 Alleles   
 Table for 10 Alleles  
 
Die Panels und BinSets müssen immer verwendet werden, die weiteren 
Auswertevorlagen sind optional. 
 
Zusätzliche Biotype® Vorlagen für die GeneMapper™ ID-X Software: 
Stutter* Chimera_Stutter_v0X oder höhere Version 

* Beim Laden der oben genannten Panels werden die Stuttereinstellungen nicht akzeptiert, die Stutterdatei 
muss daher extra importiert werden. 
 
Die empfohlenen Biotype® Vorlagen für die Genotyper® Software sind: 
Mentype_Chimera_v0 oder höhere Version 
 
 
Allgemeine Vorgehensweise bei der Auswertung 

1. Prüfen des Längenstandards (Size Standard) 
2. Prüfen der Allelleiter (Allelic Ladder) 
3. Prüfen der Positivkontrolle 
4. Prüfen der Negativkontrolle 
5. Probendaten auswerten 
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6.2 Kontrollen 

Die im PCR Amplification Kit enthaltene Kontroll-DNA XY5 sowie kommerziell 
erhältliche DNAs repräsentieren folgende Allele: 
 
Tabelle 3. Allelzuordnungen mit Mentype® Chimera® 

Locus Kontroll-
DNA XY5 

ATCC 
K-562 

CCR 
9947A 

CCR 
9948 

CCR 
3657 

Amelogenin X/Y X/X X/X X/Y X/Y 
D2S1360 22/25 20/28 23/24 22/25 22/23 
D3S1744 17/18 18/18 17/17 18/18 14/17 
D4S2366 9/12 13/13 11/13 9/14 9/14 
D5S2500 10/11 15/15 15/16 11/15 11/16 
D6S474 15/16 14/17 13/17 16/16 15/16 
D7S1517 22/27 21/24/25 19/25 20/22 24/25 
D8S1132 18/20 20/24 19/21 20/24 17/18 
D10S2325 13/14 7/13 9/10 8/14 9/14 
D12S391 17/19 23/23 18/20 18/24 18/19 
D18S51 13/15 15/16 15/19 15/18 12/20 
D21S2055 25/27 28/35 19.1/26 19.1/26 19.1/25 
SE33 15/21.2 26.2/28.2 19/29.2 23.2/26.2 22.2/27.2 
 
In der Tabelle sind die Allele von Referenz-DNA aufgezeigt, die bei ATCC 
(http://www.atcc.org/Products/PurifiedDNA.cfm#celllines) bzw. bei Coriell Cell 
Repositories (CCR; http://locus.umdnj.edu/nigms) erhältlich sind. Damit wird den 
Anforderungen von Szibor et al. (2003) entsprochen. 
 
 

6.3 Fragmentlängen und Allele 

Die in Tabelle 4 bis Tabelle 6 angegebenen Werte für Fragmentlängen einzelner 
Allele beziehen sich auf den DNA Längenstandard 550 (BTO) und die Messung am ABI 
PRISM® 310/3130 Genetic Analyzer mit POP-4 Polymer. Unterschiedliche 
Analysegeräte, DNA Längenstandards oder Polymere können zu anderen 
Fragmentlängen führen. Die Tabellen enthalten Richtwerte für die Erstellung einer 
entsprechenden Auswertungsvorlage. Eine weitere Feinabstimmung unter 
Zuhilfenahme der tatsächlich (am eigenen Gerät) gemessenen Fragmentlängen sollte 
aufgrund gerätespezifischer Abweichungen vorgenommen werden. Es wird empfohlen, 
stets zusätzlich einen visuellen Abgleich mit der entsprechenden Allelleiter 
vorzunehmen. 
 
Skalierung 

Horizontal: 70-480 bp 
Vertikal:  nach Signalintensität der Proben 
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Abbildung 6 
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Abb. 6 Elektropherogramm des Mentype® Chimera® unter Verwendung von 500 pg Kontroll-DNA XY5.  
Die Analyse erfolgte am ABI PRISM® 3130 Genetic Analyzer mit dem DNA Längenstandard 550 (BTO). 
Die Allelzuordnung wurde mit der GeneMapper™ ID Software und dem Mentype® Chimera® Template 
File durchgeführt. 
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Abbildung 7 

Abb. 7 Elektropherogramm der Allelleiter Mentype® Chimera® analysiert am ABI PRISM® 310 Genetic Analyzer.  
Die Allelzuordnung wurde mit der GeneMapper™ ID Software und dem Mentype® Chimera® Template File durchgeführt. 
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Tabelle 4. Fragmentlängen der Allelleiter Mentype® Chimera® gemessen am ABI 
PRISM® 310/3130 Genetic Analyzer (blauer Panel) 

Marker/Allel Größe [bp]* Weitere 
Allele** Marker/Allel Größe [bp]* Weitere 

 Allele** Marker/Allel Größe [bp]* Weitere  
Allele** 

Amelogenin 6-FAM  D12S391 6-FAM  D6S474 6-FAM  

X 77  15 213  13 354 11, 12 

Y 80  16 217  16.3 14 358  

   17 221 17.3 15 362  

D7S1517 6-FAM  18 226 18.3 16 366  

16 108 14, 15 19 230 19.1, 19.3 17 370  

17 112  20 234 20.3 18 374  

18 116  21 238  19 378  

19 120  22 242     

20 124  23 246   D4S2366 6-FAM  

21 128  24 250  9 429 9.2 

22 132  25 254  10 433 10.2 

23 136  26 258 27 11 437  

24 140     11.2 440  

25 144  D2S1360 6-FAM  12 441  

26 148  19 281  13 445  

27 152  20 285  14 449  

28 155 29 21 289  15 454  

   22 293     

D3S1744 6-FAM  23 297     

13 165  24 302     

14 169  25 306     

15 173  26 310     

16 177  27 314      

17 182  28 318     

18 186  29 322      

19 190  30 326      

20 194  31 330     

21 198 22 32 334     
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Tabelle 5. Fragmentlängen der Allelleiter Mentype® Chimera® gemessen am  
ABI PRISM® 310/3130 Genetic Analyzer (grüner Panel) 

 
Marker/Allel Größe [bp]* Weitere 

Allele** 
Marker/Allel Größe [bp]* Weitere 

Allele** 
Marker/Allel Größe [bp]* Weitere  

Allele** 
D8S1132 BTG  D18S51 BTG  D21S2055  BTG  

12.1 117 12, 13 8 241 7 16.1 351  

13.1 121  9 245  9.2 17.1 355  

14.1 125 14.3 10 249  18.1 359  

15 128  10.2 251  19.1 363  

16 132  11 253 11.2 20.1 367  

17 136  12  257 12.2 21.1 371  

18 140  13 261 13.2 22.1 375 22 

19 144  14 264 14.2 23 378 23.1 

20 148  15 268  24 382  

21 151  16 272 16.2 25 386  

22 155  17 276  26 390  

23 159  17.2 278 17.3 27 395  

24 163  18 279  28 399  

25 167  18.2 281  29 403  

26 171  19 283 19.2 30 406  

27 175  20 287  31 411  

   21 291  32 415  

D5S2500 BTG  21.2 293  33 419  

9 188  22 295  34 423  

10 192  23 299 23.1 35 427  

11  196  24 302  36 431  

12 200  25 306  37 435 38 

13 204  26 310  39 443  

14 208  27 314     

15 212  28 318 29    

16 216        

17 220        

18 224        
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Tabelle 6. Fragmentlängen der Allelleiter Mentype® Chimera® gemessen am  
ABI PRISM® 310/3130 Genetic Analyzer (gelber Panel) 
 
Marker/Allel Größe [bp]* Weitere 

Allele** 
Marker/Allel Größe [bp]* Weitere 

Allele** 
Marker/Allel Größe [bp]* Weitere  

Allele** 
D10S2325 BTY  SE33 BTY  SE33 BTY  

6 121  6.3 205 4.2, 5.3 25.2 278  

7 126  7.3 209 7 26.2 282 26 

8 131  8 210 8.2   27.2‡ 285 27 

9 136 9.4 9 214 9.2 28.2 289 28, 28.3 

10 141  10 218  29.2 293 29 

11 145 11.4 10.2 220  30.2 297 30 

12 150  11 222 11.2 31.2 301 31 

13 155  12 226 12.2 32 303  

14 160  13 230  32.2 305  

15 165  13.2 232 13.3 33 307  

16 170  14 234 14.2, 14.3 33.2 309  

17 175 18 15 238  34 311  

19 185  15.2 240  34.2 313  

   16‡ 241 16.2, 16.3 35 315  

   17 245 17.2, 17.3 35.2 317  

   18 249  36 318  

   18.2 251 18.3 36.2 321  

 19 253  37 322 37.2 

   19.2 255  38 326 39,42 

   20 257 20.1 49 369 50 

   20.2 259     

   21 261     

   21.2 263 22    

   22.2 267     

   23.2 270 23    

   24.2 274 24    

   25 276     

         

* gerundet auf ganze Zahlen 

** Diese „off-ladder“ Allele des Biotype DNA Pools werden mit den aktuellen Biotype® Template Files für die 
Genotyper® oder GeneMapper™ ID Software zugeordnet. Für weitere Allele siehe u.a. 
http://www.cstl.nist.gov/biotech/strbase/str_fact.htm 
‡ Diese Allele werden zur besseren Orientierung innerhalb der Allelleiter verstärkt dargestellt. 
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7. Interpretation der Ergebnisse 

Durch die vorher beschriebene Auswertung mit automatischer Allelzuordnung 
wird eine genaue und zuverlässige Unterscheidung der Allele gewährleistet. 
 
Eine automatisierte Berechnung des Spender-DNA-Anteils sowie der 
Standardabweichung und des Detektionslimits direkt aus den Rohdaten einer 
Fragmentanalyse wird z. B. mit der GenoProof®2 Software der Qualitype AG 
gewährt. 
 
Überstrahlungen (Pull-up Peaks) 

Es kann zu Überstrahlungen zwischen den Farbpanels kommen, wenn eine 
ungeeignete Matrix für die Analyse verwendet wurde oder die Peakhöhen 
außerhalb des linearen Detektionsbereiches, z.B. größer 3000 relative 
Fluoreszenzeinheiten (RFU) liegen. Diese erscheinen an der gleichen Position 
wie spezifische Peaks in anderen Farbpanels (in der Regel mit niedrigeren 
Signalintensitäten). Um Überstrahlungen zwischen den Farbpanels zu 
vermeiden, sollten die Peakhöhen daher 3000 RFU nicht wesentlich 
überschreiten.  
 
Stotterbanden (Stutter Peaks) 

Das Auftreten von Stotterbanden hängt von der Sequenz und Anzahl der 
Wiederholungseinheiten ab. Bei Tetranukleotid STR Motiven entstehen durch 
Fehler der Taq DNA Polymerase während der PCR n-4 Peaks, d.h. der 
Stutterpeak ist 4 Basen kleiner als das wahre Allel. Wiederholungseinheiten 
werden innerhalb des STR übersprungen. Zur Bewertung der Peaks gelten die 
Vorgaben der Template Files für die Genotyper® und GeneMapper™ ID 
Software. 
 
Template-unabhängige Anheftung von Nukleotiden 

Die Taq DNA Polymerase hängt aufgrund ihrer terminalen Transferase-Aktivität 
bevorzugt ein Adenosin an das 3’-Ende des amplifizierten DNA-Fragments an. 
Wenn dem PCR-System nicht genügend Zeit für die Extension zur Verfügung 
steht oder wenn die Primersequenzen die Extension nicht begünstigen, findet 
diese Anheftung nicht statt. Dieses Artefakt ist durch das Auftreten eines um 
eine Base verkürzten Fragments (-1 Peak) erkennbar. Alle Biotype® Primer 
sind so gestaltet, dass diese Artefaktbildung minimiert wird. Zusätzlich wird die 
Bildung des Artefakts durch den abschließenden Extensionsschritt im PCR-
Protokoll (68°C für 60 min) reduziert. Die Peakhöhe des Artefakts nimmt bei 
hohen DNA-Mengen zu. Zur Bewertung der Peaks sollte jedes Analyselabor 
hierfür eigene Grenzwerte festlegen. 
 
Artefakte  

Die Raumtemperatur kann das Laufverhalten der PCR-Produkte an 
Kapillargeräten stark beeinflussen und bei zu geringer Temperatur zum 
Auftreten von Schultern oder Doppelpeaks (Split Peaks) führen. Sollten diese 
Effekte beobachten werden, empfehlen wir eine erneute Injektion der Proben. 
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8. Populationsgenetische Daten 

Die wichtigsten populationsgenetischen Daten für jeden STR Marker sind in 
den folgenden Tabellen 7-10 angegeben. Die Formel für die Berechnung des 
„Polymorphism Information Content“ (PIC) wurde von Botstein et al. (1980) 
publiziert, die für die „Expected Heterozygosity“ (HET) von Nei und 
Roychoudhury (1974) sowie die für die Berechnung des „Power of 
Discrimination“ (PD) von Jones (1972). Alle Formeln sind für autosomale 
Marker geeignet.  
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Mit der GenoProof® Software der Qualitype AG können alle wichtigen 
populationsgenetischen Daten berechnet werden. 
 
 
 
Tabelle 7. Populationsgenetische Daten 

Marker D2S1360 Marker D3S1744 Marker D4S2366 

Allel Allelfrequenz Allel Allelfrequenz Allel Allelfrequenz 

19 0.007 13 0.007 9 0.347 
20 0.126 14 0.104 10 0.179 
21 0.060 15 0.053 11 0.074 
22 0.309 16 0.100 12 0.147 
23 0.142 17 0.319 13 0.168 
24 0.098 18 0.197 14 0.074 
25 0.086 19 0.130 15 0.011 
26 0.093 20 0.067   
27 0.035 21 0.023   
28 0.023     
29 0.012 PIC 0.790 PIC 0.760 
30 0.002 PD 0.943 PD 0.919 
31 0.005 HET 0.792 HET 0.795 
32 0.002     
      

PIC 0.820     
PD 0.955     
HET 0.856     
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Tabelle 8. Populationsgenetische Daten 

Marker D5S2500 Marker D6S474 Marker D7S1517 

Allel Allelfrequenz Allel Allelfrequenz Allel Allelfrequenz 

9 0.007 13 0.246 16 0.007 
10 0.084 14 0.212 17 0.007 
11 0.313 15 0.154 18 0.049 
12 0.161 16 0.285 19 0.120 
13 0.061 17 0.097 20 0.101 
14 0.042 18 0.005 21 0.099 
15 0.213   22 0.082 
16 0.103 PIC 0.740 23 0.077 
17 0.009 PD 0.918 24 0.155 
18 0.007 HET 0.733 25 0.230 
    26 0.054 

PIC 0.780   27 0.014 
PD 0.938   28 0.005 
HET 0.804     

    PIC 0.860 
    PD 0.967 
    HET 0.826 
 
 
Tabelle 9. Populationsgenetische Daten 

Marker D8S1132 Marker D10S2325 Marker D12S391 

Allel Allelfrequenz Allel Allelfrequenz Allel Allelfrequenz 

16 0.007 6 0.002 15 0.035 
17 0.095 7 0.102 16 0.019 
18 0.221 8 0.056 17 0.107 
19 0.153 9 0.121 17.3 0.019 
20 0.128 10 0.142 18 0.215 
21 0.119 11 0.144 18.3 0.007 
22 0.133 12 0.193 19 0.121 
23 0.077 13 0.133 19.3 0.016 
24 0.056 14 0.065 20 0.117 
25 0.005 15 0.037 21 0.093 
26 0.005 16 0.005 22 0.114 
27 0.002   23 0.072 
  PIC 0.860 24 0.040 

PIC 0.850 PD 0.967 25 0.021 
PD 0.964 HET 0.851 26 0.002 
HET 0.828     

    PIC 0.870 
    PD 0.971 
    HET 0.893 

 
 



 

Mentype® Chimera® September 2010 

36 

Tabelle 10. Populationsgenetische Daten 

Marker D18S51 Marker D21S2055 Marker SE33 (ACTBP2) 

Allel Allelfrequenz Allel Allelfrequenz Allel Allelfrequenz 

10 0.005 16.1 0.056 11 0.002 
12 0.103 17.1 0.021 12 0.014 
13 0.110 18.1 0.023 13 0.002 
14 0.157 19.1 0.274 13.2 0.002 
15 0.199 20.1 0.040 14 0.026 
16 0.161 21.1 0.019 15 0.049 
17 0.112 22.1 0.005 16 0.047 
18 0.072 23 0.007 17 0.070 
19 0.028 25 0.112 17.3 0.002 
20 0.030 26 0.116 18 0.044 
21 0.021 27 0.016 18.3 0.002 
24 0.002 28 0.007 19 0.082 
  29 0.030 19.2 0.009 

PIC 0.850 30 0.021 20 0.044 
PD 0.964 31 0.023 20.2 0.009 
HET 0.902 32 0.026 21 0.035 

  33 0.067 21.2 0.019 
  34 0.074 22 0.007 
  35 0.053 22.2 0.035 
  36 0.007 23.2 0.023 
  37 0.002 24 0.002 
    24.2 0.035 
  PIC 0.870 25.2 0.044 
  PD 0.971 26.2 0.040 
  HET 0.856 27.2 0.084 
    28.2 0.084 
    29.2 0.051 
    30 0.002 
    30.2 0.061 
    31.2 0.028 
    32.2 0.023 
    33 0.009 
    33.2 0.005 
    34 0.002 
    36 0.002 
      
    PIC 0.950 
    PD 0.990 
    HET 0.949 

 
Alle populationsgenetischen Daten basieren auf einer von der Biotype Diagnostic GmbH 
durchgeführten Studie an ca. 210 unverwandten Kaukasiern.  
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